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About This Manual

This manual serves as an instruction manual for the Experion™ Pro260 starter kit. General
instructions for using the Experion system and the Pro260 analysis kit, and for analyzing
protein separation data, can be found in the following:

• The Experion Pro260 analysis kit instruction manual (Bio-Rad bulletin 10000975)

• The Experion system instruction manual (Bio-Rad bulletin 10001312)

In addition, a number of tech notes, product information sheets, and fliers provide more
details about the features and applications of the Experion system. For a complete, 
up-to-date list of all Experion literature, visit www.bio-rad.com/experion/

Bio-Rad Technical Support 
The Bio-Rad technical support department in the United States is open Monday–Friday,
7:00 AM–5:00 PM, Pacific Time.

Phone: 1-800-4BIORAD (1-800-424-6723)

Fax: (510) 741-5802 

E-mail: LSG_TechServ_US@bio-rad.com (for US and international customers)

Web: www.bio-rad.com
Online technical support and worldwide contact information are available on the Web at
www.consult.bio-rad.com

Notices
No part of this publication may be reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopy, recording, or any information storage or retrieval system, without 
permission in writing from Bio-Rad Laboratories, Inc.

Bio-Rad reserves the right to modify its products and services at any time. This user guide is subject to
change without notice.

Although prepared to ensure accuracy, Bio-Rad assumes no liability for errors, or for any damages
resulting from the application or use of this information.

Microsoft and Excel are trademarks of Microsoft Corporation. VWR is a trademark of VWR International,
Inc.

LabChip and the LabChip logo are trademarks of Caliper Life Sciences, Inc.
Bio-Rad Laboratories, Inc. is licensed by Caliper Life Sciences, Inc. to sell 
products using the LabChip technology for research use only. These products
are licensed under U.S. patents 5,863,753, 5,658,751, 5,436,134, and 5,582,977,
and pending patent applications, and related foreign patents, for internal
research and development use only in detecting, quantitating, and sizing 
macromolecules, in combination with microfluidics, where internal research and
development use expressly excludes the use of this product for providing 
medical, diagnostic, or any other testing, analysis, or screening services, or 
providing clinical information or clinical analysis, in any event in return for 
compensation by an unrelated party.

Copyright © 2008 by Bio-Rad Laboratories. All rights reserved.
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Introduction — Product Description and Components

Experion™ System and Pro260 Starter Kit
The Experion automated electrophoresis system employs LabChip microfluidic technology
to automate protein and nucleic acid electrophoresis and analysis. This system integrates
separation, detection, and data analysis within a single platform and uses smaller sample
and reagent quantities than standard analysis methods. The Experion system accomplishes
analysis in a single 30 minute, automated step.

The Experion electrophoresis system includes the following components:

• Automated electrophoresis station

• Microfluidic chips

• Priming station

• Vortex station (for RNA and DNA analyses only)

• Reagents (analysis kits and individual components)

• Experion software

The Experion system includes the following components: 1) automated electrophoresis station, 2)
priming station, 3) vortex station used for nucleic acid analysis only, 4) system operation and data analysis
tools, and 5) analysis kits, which include the (a) chips and (b) reagents for protein (Pro260 kit), 
standard-sensitivity RNA (StdSens kit), high-sensitivity RNA (HighSens kit), and DNA (DNA 1K and 12K
kits) analyses.

At the center of the Experion system is the microfluidic chip, which contains a series of
plastic wells bonded over a small glass plate. The glass plate is etched with an optimized
network of microchannels, which connect with the base of the plastic wells. The channels
are primed with a gel matrix, the samples are applied to the appropriate wells, and the
electrophoresis station directs the samples through these microchannels by controlling the
voltages and currents that are applied. The microfluidic chip, in conjunction with the
Experion reagents, electrophoresis station, and software accomplish separation, staining,
destaining, detection, and basic data analysis without any user intervention.

1
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The Experion Pro260 starter kit was designed to introduce new users to protein analysis
with the Experion system as well as for performing troubleshooting, performance 
maintenance, or performance qualification of the Experion system. The starter kit is
derived from the Experion Pro260 analysis kit, which is used with the Experion system to
perform separation and analysis of proteins between 10–260 kD under denaturing conditions.
The starter kit includes the Experion Pro260 ladder, which contains nine highly purified
recombinant proteins with molecular masses from 10 to 260 kD and has been optimized
for automated electrophoresis on the Experion system. The kit also features the Pro260 
sample buffer, which contains a lower marker and an upper marker used for the proper
alignment of samples to the Pro260 ladder. The starter kit contains all of the components
of the Experion Pro260 analysis kit in addition to other supplies that allow a new user to
start using the system immediately.

For more information on protein analysis using the Experion system, refer to Appendix A of
this manual.

Kit Components and Storage Conditions

Experion Pro260 Starter Kit Components and Storage Conditions

Component Storage Conditions

Experion Pro260 chips, 3 Ambient

Reagents for analysis 4°C

Pro260 gel, 2 vials, 520 µl each

Pro260 ladder, 1 vial, 60 µl

Pro260 sample buffer, 400 µl

Pro260 stain, 45 µl

Spin filters, 2

Bovine g-globulin (BGG) standard (2.0 mg/ml), 2 ml 4°C

Dithiothreitol (DTT) 4°C

DEPC-treated1 water, 50 ml Ambient

Experion electrode cleaner, 25 ml Ambient

Experion cleaning chip, 1 Ambient

Foam swabs, 25 Ambient

Narrow-bore 20 µl pipet tips, 96 (1 rack) Ambient

0.65 ml RNase-free microcentrifuge tubes, 50 Ambient

Experion Training Video: Chip Loading (DVD) Ambient

Instructions Ambient

1 DEPC treatment of water is not required for the Pro260 assay. Use ultrapure (at minimum 0.2 µm-filtered) water. Do not use
autoclaved water.

2
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Additional Materials and Equipment Required
• Experion automated electrophoresis station
• Experion priming station
• Microcentrifuge (1,000–10,000 x g)
• Aluminum foil
• Heating block or water bath set at 95–100°C
• Benchtop vortexer
• Extra spin filter for additional filtration steps (optional, catalog #700-7254)
• Ice

The Experion Pro260 Starter Kit Tests

The Experion Pro260 starter kit includes all the reagents, consumables, and instructions
required to perform three tests, each of which demonstrates a key protein analysis function
of the Experion system. Each test uses various dilutions and preparations of a standard
protein, bovine g-globulin (BGG), and each test follows the standard Experion Pro260
assay workflow, which is summarized below.

Experion Pro260 Starter Kit Tests

Test Name Purpose Description

1 Sizing and Used for familiarization with the BGG samples are analyzed using 
relative Experion system and for standard nonreducing conditions 
quantitation troubleshooting. Demonstrates and are quantitated using relative 

the basic functions of a Pro260 quantitation against the upper 
assay and how to perform relative marker
quantitation, the easiest, fastest 
method of protein concentration 
determination. Also demonstrates 
protein sizing and how to 
determine the accuracy and 
reproducibility of a Pro260 analysis

2 Percentage Used for demonstration of the BGG samples are analyzed under 
determination percentage determination function reducing conditions to allow 

of Experion software, which can be separation of the BGG subunits. The 
used for rapid evaluation of sample heavy- and light-chain fragments are 
purity used to demonstrate the percentage

determination calculations

3 Absolute Used for demonstration of the Five BGG samples at various 
quantitation absolute quantitation method, which concentrations are used to generate 
using a involves creation of a calibration the calibration curve used for 
calibration curve. Demonstrates how to quantitation of another BGG sample
curve generate and evaluate the linearity 

of a calibration curve and how to 
determine the accuracy and 
reproducibility of absolute 
quantitation. The results 
demonstrate how use of a 
calibration curve can 
significantly improve 
quantitation accuracy

3
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Before running any of the tests:

• Watch the Experion Training Video: Chip Loading (supplied with this kit and available
at www.bio-rad.com/experion/)

• Clean the electrodes as detailed in Appendix B

Note: If this is the first time the Experion electrophoresis station is being used, refer to
Appendix C for instructions on how to prepare the system for use.

Experion Pro260 Starter Kit Test Workflow

Equilibrate the reagents

Filter the gel and prepare the gel-stain solution

Prepare the BGG dilutions

Prepare the sample buffers

Prepare the samples and the Pro260 ladder

Prime the chip

Load the chip

Perform the run within 5 minutes of chip loading and analyze the data

Set up the electrophoresis station

4
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Starter Kit Test 1 — Sizing and Relative Quantitation

1.1  Overview of Test 1

Microfluidic chips use much smaller volumes of samples and reagents than traditional slab
gels. As a result, microfluidic separations are much more sensitive to variability in pipetting
technique when compared to traditional electrophoresis methods. Proper pipetting skills
and tools are critical to a successful Experion™ analysis.

In this test, you prepare a dilution series of the bovine g-globulin (BGG) protein, run an
Experion Pro260 analysis of the series, check the resulting electropherograms for proper
performance, examine protein sizing and relative quantitation results, and export the data
to determine the accuracy and reproducibility of the analysis.

Since the use of proper pipet tips can also impact assay performance, use the narrow-bore
pipet tips included with the Experion Pro260 starter kit (or similar narrow-bore tips) for
loading samples and reagents into the microfluidic chip. Narrow-bore tips are required for
successful chip loading (other tips can introduce bubbles during chip loading, leading to
problems in performing the assay or in the quality of results).

1.2  Assay Procedure 

1.2.1  Set Up the Electrophoresis Station

Note: If this is the first time the Experion electrophoresis station is being used, refer to
Appendix C for instructions on how to prepare the system for use.

1. Power on the computer.

2. Power on the Experion electrophoresis station. Push the green button in the center of
the front panel. The steady green LED above the button indicates that the unit is on.

3. Launch Experion software. Check the screen to confirm that the instrument and 
computer are communicating properly.
When communication has been established:
• A green dot with the last four digits of the instrument serial number appears in

the lower right corner of the main software screen
• The electrophoresis station icon appears in the upper left corner 

When there is no connection, these indicators are absent and a “disconnected”
message appears next to the Start Run button in the upper left corner of the
screen. In addition, a grayed-out instrument icon appears in the upper left corner of the
software screen.

1.2.2  Equilibrate the Kit Reagents

1. Set a heating block or water bath to 95–100°C. You will use this heating block to 
denature the samples and the Pro260 ladder later in the protocol.

2. Remove the kit components from storage.

5
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• Keep the BGG standard on ice
• Equilibrate the following to room temperature for 15–20 min:

– Dithiothreitiol (DTT)
– Pro260 sample buffer (yellow cap)
– Pro260 ladder (red cap)
– 2 Tubes of Pro260 gel2 (green cap)
– Pro260 stain (blue cap)2

Notes: Keep the Pro260 stain (blue cap) and sample buffer (yellow cap) covered (for
example, with foil) at all times to avoid exposure to light.

Inspect the reagents; if the Pro260 gel (green cap) has been frozen, do not use it.

Do not store reagents at room temperature for more than 2 hr, as this will affect their shelf
life.

3. Vortex the contents of each tube and briefly centrifuge to collect the solutions at the
bottoms of the tubes. Make sure that the Pro260 stain solution (blue cap) is completely
thawed before proceeding.

1.2.3  Filter the Gel and Prepare the Gel-Stain Solution

Notes: The Experion Pro260 starter kit includes 2 spin filters, which are sufficient for
preparation of one filtered gel (G) and one gel-stain solution (GS). You will use the G and
GS in Tests 2 and 3. The prepared G and GS can be used for up to 4 weeks when stored
in the dark at 4°C between each use. The solutions can be refiltered once after that to
extend their use for another 4 weeks.

Additional spin filter tubes and reagents may also be purchased separately (see Appendix D
for ordering information).

Prepare GS as described below. Do not prepare smaller aliquots, as doing so may
adversely affect the gel-to-stain ratio, which is critical to successful staining.

1. Prepare the GS by adding 20 µl Pro260 stain (blue cap) to a tube of 520 µl Pro260
gel (green cap). (Each tube of Pro260 gel contains 520 µl gel.) Vortex the GS for 
10 sec at the highest setting and then spin it down in a microcentrifuge for a few 
seconds.

Note: Cap the Pro260 stain tightly (it contains DMSO, which is highly hygroscopic), and
store the tube in the dark (for example, cover it with foil) at 4°C.

2. Transfer the GS to a spin filter. Label the tube with “GS” and the date.

3. Pipet the contents (520 µl) of the other tube of Pro260 gel (green cap) into another
spin-filter tube. Label the tube with “G” and the date.

4. Centrifuge both spin filters for 5 min at 10,000 × g.

5. Inspect the tubes to ensure that all of the gel has passed through the filters and then
discard the filters.

6. Keep both prepared G and GS at room temperature and covered until ready for use.

2 If the filtered gel (G) and gel-stain solution (GS) were prepared previously, remove these from storage and equilibrate
them to room temperature. Do not remove the Pro260 stain.

6
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1.2.4  Prepare the BGG Dilutions 

Prepare a serial dilution of the bovine g-globulin (BGG, 2.0 mg/ml) supplied with the kit.
Label three 0.65 ml microcentrifuge tubes 1–3, and add 200 µl DEPC-treated water into
each tube. Then, add the following:

Tube 1 (1,000 ng/µl): 200 µl BGG stock solution 
Tube 2 (500 ng/µl): 200 µl BGG dilution from tube 1
Tube 3 (250 ng/µl): 200 µl BGG dilution from tube 2

Notes: You may also use samples 1 and 2 in Test 23. If running samples over multiple
days, store these samples at 4°C between uses.

1.2.5  Prepare the Sample Buffers

Protein samples can be separated under either reducing or nonreducing conditions, but
the Pro260 ladder must always be run under reducing conditions. Reduced and nonreduced
samples may be run on the same chip. Prepare fresh sample buffer each day that an
assay is run.

The starter kit includes dithiothreitol (DTT) in place of the b-mercaptoethanol specified in
the Experion Pro260 analysis kit instruction manual. For the purpose of Experion Pro260
analysis, these reducing agents are interchangeable.

1. Reconstitute the DTT by adding 1 ml DEPC-treated water. This solution remains stable
for weeks after preparation if stored at –20°C.

2. Transfer 30 µl sample buffer (yellow cap) to a 0.65 ml microcentrifuge tube. Add 1 µl of
the reconstituted DTT solution, and label this tube “R” for “reducing”.

3. Transfer another 30 µl sample buffer (yellow cap) to another 0.65 ml microcentrifuge
tube. Add 1 µl DEPC-treated water, and label this tube “NR” for “nonreducing”.

Note: When you are finished preparing the sample buffers, return the stock sample buffer
(yellow cap) to storage at 4°C and the reconstituted DTT to storage at –20°C. Protect all
tubes containing sample buffer from direct sunlight.

3 Do not use these samples for Test 3. For Test 3, prepare the entire dilution series as directed and at the same time for
best results.

7
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1.2.6  Prepare the Samples and the Pro260 Ladder

1. Prepare the Pro260 ladder. Mix 4 µl Pro260 ladder (red cap) and 2 µl sample buffer
“R” (reducing sample buffer) in a 0.65 ml microcentrifuge tube. Vortex the tube briefly
and spin down for a few seconds. Label the tube “L”.

2. Prepare the samples (S1–S3). Label three 0.65 ml microcentrifuge tubes “S1”, “S2”,
and “S3”. For each sample, combine 4 µl of the BGG samples in tubes 1–3 (from
Section 1.2.4) with 2 µl sample buffer “NR” (nonreducing).

3. Vortex all tubes briefly and spin down in a microcentrifuge for a few sec.

4. Place the sample tubes S1–S3 and the Pro260 ladder (L) in a 95–100°C heating block
for 3–5 min.

5. Spin the tubes for 15 sec, add 84 µl DEPC-treated water to each tube, and vortex
briefly to mix.

1.2.7  Prime the Chip

Before priming the chip, be sure that all samples, the Pro260 ladder, and other reagents
are prepared and ready to be loaded. If a chip is not used within 5 min of priming and
loading, reagents may evaporate, leading to poor results. Use the narrow-bore pipet tips
that are supplied with the kit (or equivalent tips) when loading samples and reagents into
the chip.

1. Pipet 12 µl GS into the top right well labeled GS (gel priming well) (Figure 1.1). Insert
the pipet tip vertically and to the bottom of the well when dispensing. Dispense slowly,
and do not expel air at the end of the pipetting step.

Note: Placing the pipet tip at the edge of the well or allowing the gel to slide down the wall
of the well may lead to bubble formation at the bottom of the well. Dislodge any bubbles at
the bottom of the well with a clean pipet tip, or remove the GS and load it again. For help
with chip loading, refer to the Experion Training Video: Chip Loading.

Fig. 1.1. Experion Pro260 chip. The locations of the gel priming well (GS) and alphanumeric priming
code are indicated.

8
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2. Set the pressure setting to B and the time setting to 3, as specified by the alphanumeric
code on the chip (Figure 1.1).

3. Open the Experion priming station by pressing down on the lever on the front.

4. Place the chip on the chip platform, matching the arrow on the chip with the alignment
arrow on the chip platform. A post on the chip prevents insertion in the wrong position.
Do not force the chip into position.

5. Carefully close the priming station by pressing down on the lid. The lid should snap
closed.

6. Press the Start button. A “Priming” message appears on the screen of the priming 
station, the priming station pressurizes, and the timer begins to count down. Priming
requires approximately 60 sec to complete. Do not open the priming station during the
countdown.

7. An audible signal and “Ready” message indicate that priming is complete. Open the
priming station by pressing down on the release lever.

Note: If the lid sticks, press down on it while pressing down on the release lever.

8. Remove the chip from the priming station, turn it over, and inspect the microchannels
for bubbles or evidence of incomplete priming. If the chip is primed properly, the
microchannels are difficult to see (it may be helpful to compare a primed chip to a
new, unused chip). If you detect a problem, such as a bubble or incomplete priming,
prime a new chip.

9. Place the chip on a clean surface for loading.

1.2.8  Load the Chip

1. Using a pipet, remove and discard any remaining GS from the gel priming well 
(Figure 1.1).

2. Pipet 12 µl GS into all four wells labeled GS (including the gel priming well) (Figure 1.2).

3. Pipet 12 µl filtered gel (G) into the well labeled G (Figure 1.2).

Fig. 1.2. Experion Pro260 chip. GS, gel-stain solution; G, gel; 1–10, samples; L, Pro260 ladder.

9

Load GS into 4 wells labeled "GS"

Load ladder into the well labeled "L"

Load samples into wells 1–10

Load G into the well labeled "G"
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4. Pipet 6 µl of each diluted sample into sample wells 1–10. Use the layout shown in
Figure 1.3.

S3 S2 S1 GS

S3 S2 S1 GS

S3 S2 S1 GS

S3 L GS G

Fig. 1.3. Chip layout for Test 1. S1–S3, sample numbers; GS, gel-stain solution; G, Pro260 gel; L,
Pro260 ladder.

5. Inspect all wells to make sure that there is no excessive bubble formation from pipetting.
Hold the chip above a light-colored background and look down through the wells
(Figure 1.4). Dislodge any bubbles at the bottom of the well with a clean pipet tip or by
removing and reloading the solution.

6. Pipet 6 µl diluted Pro260 ladder into the ladder well labeled L (Figure 1.3). Use the
Pro260 ladder within 8 hr of preparation. Every chip must have the Pro260 ladder
loaded into the ladder well labeled L.

Fig. 1.4. Bubble formation during loading of Experion Pro260 chips. Left, example of bubbles
trapped at the bottom of wells. The GS and G wells and sample wells 1, 3, and 4–6 contain no solution.
Well 10 is filled properly and has no bubbles; large bubbles have formed at the bottom of wells 8 and 9
and in the ladder well (L). Note the difference in the diameter of the light-colored circles in wells 10 and
L. Right, example of bubble formation at the surface of wells. Small bubbles have formed at the surface
of the three GS wells on the right side of the chip, and the rest of the wells have no bubbles. Surface
bubbles should not cause problems during a run, but bubbles at the bottoms of wells must be removed.

7. Place the loaded chip into the Experion electrophoresis station and start the run. It is
important to run a loaded chip immediately (within 5 min). Otherwise, excess 
evaporation may occur, leading to poor results or to a chip performance error.

10
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1.2.9  Run the Pro260 Analysis

1. Open the lid of the electrophoresis station by pulling the release latch. Place the
primed and loaded chip on the chip platform and close the lid.

2. In the Experion software toolbar, click the New Run button . The New Run
screen opens (Figure 1.5).

Fig. 1.5. Details of the New Run screen. The green dot in the lower right corner indicates that 
communication between the electrophoresis station and Experion software has been established.

3. From the Assay drop-down list, select Protein > Pro260.

4. Select a project folder for the run from the Project drop-down list.

-Or- 

Create a new project folder by typing a name in the Project field or by selecting 
File > Project > New.

The project folder appears in the project tree after the run has started.

5. Enter a name for the run in the Run Prefix field.

6. Click the Start Run button at the top of the window to start the run. The New Run
dialog opens (Figure 1.6).

11
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Fig. 1.6. New Run dialog. The Experion system stops analysis when it reaches the number of samples
entered.

7. Select the number of samples to be analyzed (10 for all three tests).

8. Click Start to begin the chip run. The green LED in the center of the front panel on the
electrophoresis station blinks once the run has started.

Warning: Do not open the lid of the Experion electrophoresis station until the run is 
complete. The lid does not lock. Opening the lid prematurely aborts the run.

The system performs a number of checks at the beginning of a run: it confirms that a chip
has been inserted, that all wells contain liquid, that electrical connections are made, etc. A
calibration counter marks the progress of these calibrations in the upper right corner of the
screen.

Note: An “IV Check Error” message indicates the system cannot make electrical contact in
one or more of the wells. This often means that either there is a bubble at the bottom of a
well or that a well is empty. If this message appears, abort the run, and check the chip for
bubbles or empty wells. Refill the affected well(s), and start the run again.

9. Enter the sample names in the Sample Information window. For example, for wells 1,
4, 7, and 10, enter “S3”. In addition, add sample details, such as sample concentration.
Alternatively, enter this information after the run is complete using the Run Info tab.

10. During separation, the sample name is highlighted in gray in the project tree, and the
electropherogram trace and virtual gel bands appear in real time. By default, the 
electropherogram of the sample being separated appears in the electropherogram
view; in the gel view, the lane corresponding to that sample is outlined in pink and has
a dark background. To display the electropherogram from another sample that has
already been separated, click on either the sample name in the project tree or on a
lane in the virtual gel.

11. When the analysis is complete (after approximately 30 min), the instrument beeps and
a window opens indicating the end of the run. Select OK to the prompt and remove the
Pro260 chip from the chip platform.

12
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12. Clean the electrodes using the DEPC-treated water provided in the kit (see Appendix B,
routine cleaning). DEPC-treated water is not required for this cleaning application;
however, always use ultrapure (at minimum 0.2 µm-filtered) water.

13. Analyze the run and the data.

1.3  Data Analysis
Evaluate the performance of Test 1 and the analysis of the data by the Experion software.

1. Evaluate the virtual gel to ensure that all lanes (samples) are visible. Check that the
upper and lower markers are present in each sample (indicated by pink triangles) and
that they are aligned across all lanes (Figure 1.7).

2. Modify the gel view by changing the fluorescence intensity scale. By default, Experion
software displays the virtual gel and electropherograms as “scaled to local”, which
means the gel lane or trace of each sample is scaled to the highest peak intensity
detected in that sample. This is the best method for viewing an electropherogram. To
adjust the fluorescence intensity scale so that the virtual gel resembles an SDS-PAGE
separation, select Graph > Scale to Global. The virtual gel appears as it does in
Figure 1.7, right panel. All lanes are scaled to the highest peak found across the entire
chip, which enables better definition of the concentration differences among the samples
in the virtual gel.

Fig. 1.7. Virtual gel generated by Test 1. Left, virtual “scaled to local”. Right, virtual gel “scaled to global”.
L, Pro260 ladder; lanes 1, 4, 7, and 10, 250 ng/µl BGG; lanes 2, 5, and 8, 500 ng/µl BGG; lanes 3, 6,
and 9, 1,000 ng/µl BGG. Using the “scale to global” option allows clearer distinction of the concentration
differences among samples.

3. Evaluate the separation of the Pro260 ladder (Figure 1.8). This is a critical step in data
analysis because much of the automated data analysis performed by Experion software
is based on the successful separation of the Pro260 ladder. To display the ladder 
electropherogram, click the ladder well in the project tree or click on the lane labeled L
in the virtual gel. The electropherogram should resemble the one shown below and
should have the following features:

• Two marker peaks and one set of system peaks

• 8 Pro260 ladder peaks located between the system peaks and upper marker

13

10010510A.qxp  2/13/2008  11:43 AM  Page 13



• Flat baseline

• Marker peaks at least 20 fluorescence units above the baseline

Fig. 1.8. Electropherogram showing the separation of the Pro260 ladder. Note the flat baseline and
well-resolved peaks. All identified peaks are numbered, and the lower and upper markers are indicated
by green asterices. The 260 kD protein in the Pro260 ladder is labeled as the upper marker by Experion
software.

4. Examine the separation of the 1,000 ng/µl BGG sample (S1). Click on the sample
name in the project tree or on lanes 3, 6, or 9 in the virtual gel. The electropherogram
appears and should have the following features (Figure 1.9):

• Two well-resolved marker peaks and one set of system peaks

• Sample peaks located between the system peaks and upper marker

• Flat baseline

• Marker peaks at least 20 fluorescence units above the baseline

14
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Fig. 1.9. Electropherogram showing the separation of the 1,000 ng/µl sample under nonreducing
conditions.

5. Peaks identified by Experion software are automatically labeled with numbers for easy
identification, and the upper and lower markers used for normalization are indicated in
green with an asterisk (*). To change the type of label displayed, select Graph > Peak
Info or use the drop-down menu and select among the following options:

Peak number –– uses sequential numbers for peak identification (default selection)

Peak time –– uses peak migration time (min:sec) for the peak labels

Peak height –– uses peak height in units of fluorescence intensity for peak labels

Peak corrected area –– uses calculated (corrected) peak area for peak labels

Molecular weight –– uses calculated molecular weight (kD) for peak labels

Peak concentration –– uses calculated concentration (ng/µl) for peak labels

6. Evaluate the data analysis performed by Experion software. Click on the Results tab
and click on any sample in the virtual gel to view the data for that sample.

– To evaluate sizing, examine the values provided in the Mol. Wt. (kD) column for each
sample. BGG is peak 4 in the electropherogram in Figure 1.9 (well 3), and the peak
size is ~158.26 kD.

– To evaluate relative quantitation of the BGG peak, examine the values provided in
the Concentration (ng/µl) column for each sample.

7. Evaluate the reproducibility of the sizing calculation using the coefficient of variation
(%CV), which should be £10%. Click on the Protein Search Criteria tab and click on
the Add Protein Name icon . Replace Change Protein Name 1 with BGG in the
Protein Name column, enter 160 in the Mol Wt. column, and enter 16 in the ± kDa
column.
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8. Click the Protein Search Results tab and scroll down to find the %CV calculation. In
the example given in Figure 1.10, the %CV is 1.55%.

Fig. 1.10. Results table from Test 1 showing reproducibility of protein sizing. In this example, the
%CV for sizing is 1.55%. Note that the apparently large %CV for concentration is misleading (different
sample concentrations were analyzed).

9. To perform a qualitative evaluation of quantitation reproducibility, overlay the 
electropherograms of replicate samples. For example, in the virtual gel, select lane 3
and hold the Ctrl key while selecting lanes 6 and 9. The electropherograms from these
wells (1,000 ng/µl samples) overlap (Figure 1.11). Tighter overlaps signify better 
reproducibility. Repeat this step for the other two concentrations examined.

Fig. 1.11. Electropherogram overlay of the 1,000 ng/µl samples. The virtual gel (right) shows that the
samples in wells 3, 6, 9 are being compared.
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10. The relative concentration of the BGG, as determined against the known concentration
of the upper marker, is shown in the Concentration (ng/µl) column. To perform an
evaluation of quantitation reproducibility, calculate the %CV, which is defined as the
standard deviation/mean x 100. To do this, export the data to a Microsoft Excel or other
spreadsheet application either by entering the values manually in Excel or by using the
data export feature of Experion software.

11. To export the Protein Table data:

Click the Protein Search Results tab. Right-click on the table, select Copy Table(s) >
Selected Table to Clipboard, and paste into an Excel spreadsheet. Delete the three
lines of calculation at the bottom.

-Or-

Select File > Export Data… The Export window opens. Deselect Result Table, and
select Protein Table. Click Export.
In the Save As window, name the file and designate a folder for it. Click Save.

Open the file in Excel software. Delete the three lines of calculation at the bottom.

12. In the Excel spreadsheet, sort the data by protein concentration. Insert a column
between columns D and E, and label it Exp Conc (Expected Concentration). Enter the
expected concentration for each well (enter 250 for wells 1, 4, 7, and 10; 500 for wells
2, 5, and 8; 1,000 for wells 3, 6, and 9). Do not enter units, as these will interfere with
the sort function. Place the cursor on column E (Exp Conc) and select Data > Sort.

13. Insert 3 columns after column G, and label them Mean Conc, Stdev, and %CV. Use
Excel software to determine the mean, standard deviation, and the %CV (standard
deviation/mean x 100) for each set of replicates (each concentration examined). The
%CV for this test should be £20%.

Expected Performance of BGG in Test 1

Measurement Typical Results

Sizing

Reproducibility %CV £ 10%

Accuracy 160 ± 16 kD

Relative quantitation

Reproducibility %CV £ 20%
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Notes: The Experion system uses a single-point calibration to the upper marker protein for
relative quantitation; therefore, relative quantitation accuracy is often highest for proteins
that stain with similar efficiency to the upper marker protein. Though the accuracy of this
method for some proteins can be high (within <0.5% of expected)4, accuracy for other 
proteins, such as the BGG standard protein, may not be as good. Such differences in 
quantitation accuracy for different proteins also occur with other commonly used protein
quantitation methods, such as the Bradford and Lowry assays5–8, and are often due to 
differences in protein staining efficiency; unique protein characteristics can affect the levels
of staining and colorimetric signals produced.

Because proteins exhibit differences in staining behavior, alternative protocols exist for their
quantitation: relative quantitation against a user-defined internal standard and absolute
quantitation. Perform Test 3 to see how absolute quantitation improves quantitation accuracy
for the BGG standard. For more information on the quantitation methods used by Experion
software, refer to Appendix A.

If your results do not appear as they do in these examples, refer to the troubleshooting 
section of the Experion Pro260 analysis kit and Experion system instruction manuals.
Typically, problems with reproducibility are due to problems with pipetting or chip loading.
For tips on optimizing your results, refer to the Experion Training Video: Chip Loading and
the Essential Practices and Troubleshooting sections of the Experion system instruction
manual.

4 Nguyen M and Strong W, Performance comparison of the Experion automated electrophoresis system and a competing
automated system for protein analysis, Bio-Rad bulletin 5302 (2005)

5 Bio-Rad bulletin 1069, Colorimetric protein assays
6 Bradford MM, A rapid and sensitive method for the quantitation of microgram quantities of protein utilizing the principle of

protein-dye binding, Anal Biochem 72, 248–254 (1976)
7 Lowry OH et al., Protein measurement with the Folin reagent, J Biol Chem 193, 265–275 (1951)
8 Wu F and Strong W, Comparison of protein quantitation methods using the Experion automated electrophoresis system,

BioRadiations 123, 28–31 (2007)
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Starter Kit Test 2 — Percentage Determination

2.1  Overview of Test 2
In this test, you examine the separation of the BGG standard under reducing conditions and
different total protein concentrations. Under reducing conditions, BGG separates into light-
and heavy-chain fragments. These fragments are used to highlight the percentage 
determination function of Experion™ software, which calculates each fragment as a percent
of the total protein species in a sample. This quantitation method is fast, reliable, accurate,
and easy to perform; it is particularly useful for routine quality control experiments to evaluate
the purity of known proteins.

In this test, note that the relative abundance of light- and heavy chain fragments does not
change, regardless of the total protein concentration analyzed.

2.2  Assay Procedure
1. Set up the electrophoresis station, equilibrate the reagents to room temperature, and

prepare the gel (G) and gel-stain solution (GS) as outlined in Sections 1.2.1–1.2.3. If
the G and GS have already been prepared, equilibrate them as detailed in Section
1.2.2.

2. This protocol uses 1,000 and 500 ng/µl dilutions of BGG. Label 2 microcentrifuge tubes
(1–2) and add 200 µl DEPC-treated water into each tube. Then add the following:

Tube 1 (1,000 ng/µl): 200 µl BGG stock solution 

Tube 2 (500 ng/µl): 200 µl BGG dilution from tube 1

Note: If you have recently run Test 1 or 3 (within a month and using proper storage at 4°C),
you can use the 1,000 and 500 ng/µl dilutions prepared for those tests in this test.

3. Prepare the reducing sample buffer (“R”) as described in Section 1.2.5. For this test, do
not prepare nonreducing buffer (“NR”). Prepare fresh sample buffer each day that an
assay is run.

4. Prepare the samples S1 and S2 and the Pro260 ladder as described in Section 1.2.6,
except use reducing buffer (“R”) for preparing both the samples and the Pro260 ladder.

5. Prime and load the chip as described in Sections 1.2.7 and 1.2.8 and using the chip
layout shown in Figure 2.1.

S2 S1 S2 GS

S1 S2 S1 GS

S2 S1 S2 GS

S1 L GS G

Fig. 2.1. Chip layout for Test 2. S1–S2, sample numbers; GS, gel-stain solution; G, Pro260 gel; L,
Pro260 ladder.

6. Run the Pro260 analysis as described in Section 1.2.9. Enter the sample names and 
information appropriate to the chip layout for Test 2 (Figure 2.1) .
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2.3  Data Analysis
Evaluate the run and the analysis of the data by the Experion software.

1. Evaluate the virtual gel to ensure that all lanes (samples) are visible. Check that the
upper and lower markers are present in each sample (indicated by pink triangles) and
that they are aligned across all lanes. Select Graph > Scale to Global to adjust the 
virtual gel so that it resembles an SDS-PAGE separation (Figure 2.2).

Fig. 2.2. Virtual gel generated by Test 2. L, Pro260 ladder; lanes 1,3,5,7, and 9, 500 ng/µl BGG; lanes
2,4,6,8, and 10, 1,000 ng/µl BGG. In this example, the virtual gel was “scaled to global”.

2. Evaluate the separation of the Pro260 ladder. This is a critical step in data analysis
because much of the automated data analysis performed by Experion software is
based on the successful separation of the Pro260 ladder. To display the ladder 
electropherogram, click the ladder well in the project tree, or click on the lane labeled L
in the virtual gel. The electropherogram should resemble the one shown in Figure 1.8.

3. Examine the separation of 1,000 ng/µl BGG sample (S1). Click on the sample name in
the project tree or on the lane in the virtual gel. The electropherogram appears and
should appear as shown in Figure 2.3. Under reducing conditions, BGG separates into
light- and heavy-chain fragments; therefore, the electropherogram in Figure 2.3 has
more peaks than does the electropherogram in Figure 1.9 (non-reducing conditions).

20

10010510A.qxp  2/13/2008  11:43 AM  Page 20



Fig. 2.3. Separation of the 1,000 ng/µl sample under reducing conditions. Under reducing conditions,
BGG separates into light- and heavy-chain fragments.

4. Evaluate the percentage determination by Experion software (% Total calculation). Click
on the Results tab, click on lane 2 in the virtual gel, and evaluate the values provided
in the % Total column for each peak. For the sample shown in Figures 2.3 and 2.4, the
light- and heavy-chain peaks correspond to peaks 6 and 8 and represent 34% and
62% of the total protein concentration, respectively.

Fig. 2.4. Results table from Test 2 showing % Total (percentage determination) calculations.
Results are shown for each of the peaks in the electropherogram shown in Figure 2.3.
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5. Examine the % Total values for these peaks in both sample concentrations. Note that,
regardless of the total sample concentration, the percentage of total represented
remains the same.

Expected Performance for BGG in Test 2

Measurement Typical Results

% Total (Percentage determination)

Ligh-chain fragment 33–43% Total protein

Heavy-chain fragment 57–67% Total protein

If your results do not appear as they do in these examples, the most likely cause is 
insufficient reducing conditions in the sample buffer. Ensure that reducing buffer (“R”) was
used to prepare samples and check that DTT was stored properly (at 4°C or reconstituted
at –20°C).

Percentage determination is a particularly simple method of protein of quantitation because
it does not rely on any internal standard. It is a highly reproducible qualitative method for
estimating protein levels and purity, and it is a good method for tracking sample quality 
without relying on absolute concentrations.
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Starter Kit Test 3 — Absolute Quantitation Using a
Calibration Curve

3.1  Overview of Test 3
In this test, you create a calibration curve that you use to determine the concentration of a
standard protein. You evaluate the linearity of the curve and check sizing and reproducibility.
Experion™ software reports the results from relative and absolute quantitation methods 
side-by-side in the results table. The results of this test demonstrate how use of a calibration
curve can significantly improve the accuracy of quantitation.

3.2  Assay Procedure
1. Set up the electrophoresis station, equilibrate the reagents to room temperature, and

prepare the gel (G) and gel-stain solution (GS) as outlined in Sections 1.2.1–1.2.3. If
the G and GS have already been prepared, equilibrate them as detailed in Section
1.2.2.

2. Prepare a serial dilution of the bovine g-globulin (BGG, 2.0 mg/ml) supplied with the kit.
Label six 0.65 ml microcentrifuge tubes 1–6. Tubes 1–5 are calibrants for creating the
standard curve; tube 6 is the sample for analysis and quantitation (that is, your
“unknown”).

Add 200 µl DEPC-treated water into each of the five calibrant tubes. Then add the following:

Tube 1 (1,000 ng/µl): 200 µl BGG stock solution 

Tube 2 (500 ng/µl): 200 µl BGG dilution from tube 1

Tube 3 (250 ng/µl): 200 µl BGG dilution from tube 2

Tube 4 (125 ng/µl): 200 µl BGG dilution from tube 3

Tube 5 (62 ng/µl): 200 µl BGG dilution from tube 4

For tube 6 (400 ng/µl), combine 25 µl DEPC-treated water with 100 µl BGG dilution from
tube 2.

3. Prepare both the reducing and nonreducing sample buffers (“R” and “NR”) as
described in Section 1.2.5. Prepare fresh sample buffer each day that an assay is run.

4. Prepare the samples and Pro260 ladder as described in Section 1.2.6. Use reducing
buffer (“R”) for preparing the Pro260 ladder L; use nonreducing sample buffer (“NR”) for
preparing samples S1–S6.

5. Prime and load the chip as described in Sections 1.2.7 and 1.2.8 and using the chip
layout shown in Figure 3.1.

S6 S6 S6 GS

S5 S4 S3 GS

S2 S1 S6 GS

S6 L GS G

Fig. 3.1. Chip layout for Test 3. S1–S6, sample numbers; GS, gel-stain solution; G, Pro260 gel; L,
Pro260 ladder.

6. Run the Pro260 analysis as described in Section 1.2.9. Enter the sample names and 
information appropriate to the chip layout for Test 3 (Figure 3.1).

23

10010510A.qxp  2/13/2008  11:43 AM  Page 23



3.3  Data Analysis
Evaluate the run and the analysis of the data by Experion software.

1. Evaluate the virtual gel to ensure that all lanes (samples) are visible. Check that the
upper and lower markers are present in each sample (indicated by pink triangles) and
that they are aligned across all lanes. Select Graph > Scale to Global to adjust the 
virtual gel so that it resembles an SDS-PAGE separation (Figure 3.2).

Fig. 3.2. Virtual gel generated by Test 3. L, Pro260 ladder; lanes 1–3, 9, and 10, BGG sample
(“unknown”); lanes 4–8, BGG calibrants. In this example, the virtual gel was “scaled to global”.

2. Evaluate the separation of the Pro260 ladder. This is a critical step in data analysis
because much of the automated data analysis performed by Experion software is
based on the successful separation of the Pro260 ladder. To display the ladder 
electropherogram, click the ladder well in the project tree, or click on the lane labeled L
in the virtual gel. The electropherogram should resemble the one shown in Figure 1.8.

3. Examine the separation of the 1,000 ng/µl BGG sample (S1). Click on the sample
name in the project tree or on the lane in the virtual gel. The electropherogram appears
and should resemble the electropherogram shown in Figure 1.9.

4. Under the Run Info tab, designate the wells that contain the proteins for the calibration
curve (wells 4–8 in the Use as Standard column) and enter their concentrations
(Figure 3.3). Click Apply.
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Fig. 3.3. Designating calibrants in the Run Info tab.

5. Select Analysis > Internal Std. and Std Protein Calibration Curve. The Internal Std.
and Std Protein Calibration Curve window appears.

6. Next to Standard Protein Molecular Weight (Figure 3.4), enter 160 (the region in
which the software searches for a peak). Click Apply to update the calculation.

Fig. 3.4. Internal Std. and Std Protein Calibration Curve window.

7. The calibration curve appears and displays the statistical relevance of the regression.
Evaluate the R Square value; it should be 0.97.£
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8. In the Results table, the concentration for each protein identified by Experion software
is derived by relative quantitation against the 260 kD upper marker and appears in the
Concentration column; the calibrated concentrations of proteins found in the size
region specified appear in the Calib. Conc. column. The expected concentration for
peak 4 (BGG) is 400 ng/µl. In the example in Figure 3.5, relative quantitation against
the upper marker yielded a concentration of 574.0 ng/µl, while absolute quantitation
yielded a concentration of 413.1 ng/µl.

Fig. 3.5. Results table from Test 3 showing relative quantitation (Concentration) and absolute
quantitation (Calib. Conc.) calculations.

9. To evaluate the reproducibility of absolute quantitation, determine the %CV for wells
1–3, 9, and 10. Copy the data to Excel software and determine %CV as the standard
deviation/mean x 100. Values should be £20%.

10. Calculate the mean concentration determined for the unknown samples. Note that the
absolute quantitation method generates values that are more accurate (closer to the
expected value of 400 ng/µl) than those derived by relative quantitation. Accuracy
should be within 20% for 400 ng/µl BGG.

Expected Performance of BGG for Test 3

Measurement Typical Results

Linear regression (calibration curve) r2 0.97

Absolute quantitation

Reproducibility %CV £ 20%

Accuracy 400 ± 80 ng/µl
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Appendix A — How the Experion™ System Works 
The Experion electrophoresis system performs electrophoresis of samples within a 
microfluidic chip. Within each chip, a series of microchannels connects the sample wells to a
separation channel and buffer wells. A set of electrodes in the electrophoresis station
applies a voltage across the microchannels, causing charged molecules in the samples to
migrate into and through the separation channel. Samples are run sequentially, with a 
sufficient lag between them to prevent cross-contamination. For separation, the microchannels
are filled with a proprietary gel-stain solution (GS) that acts as a sieving matrix; therefore,
the sample fragments migrate through the separation channel at a rate based on their size
and charge. Finally, sample fragments interact with a fluorescent dye during separation and
are detected as they pass by a laser and a photodiode detector.

Protein analysis is accomplished with the Experion Pro260 analysis kit and involves the 
following steps:

1. Preparing the chip (priming and loading) –– Priming fills the microchannels of the
microfluidic chip with the gel-stain solution, which contains both the sieving matrix and
fluorescent dye. Protein samples are then prepared in Pro260 sample buffer, which
contains lithium dodecyl sulfate (LDS), and are added to the sample wells.

2. Running the chip –– The chip is inserted into the electrophoresis station, and as the
instrument lid is closed, electrodes come in contact with the solution in the wells.
Voltage is applied to the sample wells of the chip, causing the charged, LDS-coated
protein ions to migrate into the separation channel. In the separation channel, the 
different proteins separate as they move at different rates through the gel matrix,
depending on their size. During separation, the fluorescent dye associates with the
LDS micelles coating the proteins and with free micelles9.

3. Detecting the fragments –– As the fragments migrate towards the end of the 
separation channel, destaining occurs. Pro260 gel (G), which does not contain dye or
LDS, flows alongside the sample. Diffusion of free LDS into this detergent-free zone
reduces the concentration of LDS below its critical micellar concentration, releasing dye
molecules from unbound micelles. When it is free of the hydrophobic interior of the LDS
micelle, the dye fluoresces weakly; the background signal is thus reduced. Dye-micelle
complexes are more stable to the destaining process when they are bound to proteins.
Downstream from where destaining occurs, a laser beam excites the dye, causing it to
fluoresce if it is bound to the LDS micelle-protein complexes. A photodiode detects the
fluorescence, and Experion software plots the fluorescence intensity versus time to 
produce an electropherogram and a virtual gel image.

4. Analyzing the data –– Following separation, Experion software subtracts background
noise, removes spikes, identifies and integrates peaks, and assigns their sizes and
concentrations. Following analysis, parameters may be changed and the data 
reanalyzed.

9 An important difference between the Experion system and traditional sodium dodecyl sulfate polyacrylamide gel 
electrophoresis (SDS-PAGE) lies in how sample fragments are detected: in SDS-PAGE, samples are generally stained in
the gel once separation is completed, while in the Experion system proteins are stained with a fluorescent dye during 
separation.
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How Experion Software Analyzes Proteins

Data Presentation

As the photodiode detects fluorescent signals from the dye-protein-LDS complexes,
Experion software converts the signal into an electropherogram (a plot of fluorescence vs.
time). Experion Pro260 electropherograms generally have the following features:

Sample peak(s) –– signal(s) generated by the sample protein(s)

System peaks –– cluster of signals generated by fluorescent detergent micelles. The system
peaks are not considered in the quantitative concentration estimation

Upper and lower marker –– signals generated by the internal upper (260 kD) and lower
(1.2 kD) markers, which are included in the sample buffer and used to normalize the 
separation of proteins across all wells in the chips. The upper marker is also used as an
internal standard for relative quantitation (see below). For each lane, comparison of the area
of this peak with the area of every detected peak allows estimation of relative concentration

Electropherogram generated by Experion Pro260 analysis of bovine gg-globulin (BGG). The relative
positions of the lower marker, system peaks, sample peak (BGG), and upper marker are shown.

Once separation occurs, these data are then converted into a densitometric, gel-like image,
or virtual gel. Each lane in the virtual gel corresponds to a different sample. The sample and
system peaks and upper and lower markers seen in the electropherogram also appear in
the virtual gel.
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Virtual gel generated by Experion Pro260 analysis. Shown are separations of the Pro260 ladder (L)
and 10 samples on the same chip.

Once separation is complete, the software subtracts background noise, removes spikes,
identifies and integrates peaks, and assigns their sizes and concentrations. Proteins are
identified as peaks in the electropherograms and as bands in the virtual gel. The results of
data analysis are also tabulated and presented in a Results table at the end of analysis. The
types of data available include the following:

• Protein size (or mass, in kD)

• Protein concentration (in ng/µl) derived by relative and/or absolute quantitation

• % Of total sample (derived by percentage determination)
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Results table generated by Experion Pro260 analysis.

Data Analysis: Normalization, Sizing, and Quantitation
Following separation, Experion software analyzes protein fragments using one or more of
the following:

• Internal markers for normalizing the migration times of samples in different wells

• Pro260 ladder for determining fragment size (sizing)

• Internal markers or calibrants for determining concentration (quantitation)

Normalization: Aligning the Protein Peaks
To compensate for small variations in samples or factors influencing separation (pH, salt
concentration, injection volumes, separation field, etc.), Experion Pro260 analysis uses two
internal markers to normalize the migration times between samples. The two internal markers,
an upper marker (260 kD) and lower marker (1.2 kD), are included in the Experion Pro260
sample buffer. Therefore, both of these markers are added to each sample and the Pro260
ladder. Inclusion of these markers and the normalization process ensures that the system
software properly identifies peaks.

Protein Sizing
The first sample to be analyzed is the Pro260 ladder, a modified version of the Precision
Plus Protein™ standards that has been optimized for automated electrophoresis on the
Experion system. The Pro260 ladder contains nine purified, recombinant proteins of
10–260 kD. Experion software constructs a standard curve of migration time as a function
of size from the Pro260 ladder separation. It then calculates the size of the proteins from
the sample wells by comparing their migration times to the standard curve.

Protein Quantitation
Experion software offers two different types of protein quantitation methods: percentage
determination and concentration determination. All protein quantitation measurements are
based on the time-corrected peak area (corrected area) of each peak identified in an 
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electropherogram. The corrected area of a peak is proportional to the amount of the protein
it represents in a mixture.

Percentage determination –– measures the percentage of each protein in a protein mixture
(% Total). This method is commonly used for determining protein content, protein purity, and
protein stability

Concentration determination –– provides the amount of the protein(s) in a protein mixture
rather than just a percentage of the total. There are several different ways that concentration
determination can be performed, and these methods provide more or less precision
depending on the type of internal standard used and the extent to which a calibration curve
is used 

Relative quantitation –– Experion software uses an internal standard to estimate the
concentrations of sample proteins. Estimates are calculated by comparing the corrected
peak area of the sample peak to that of the internal standard in each sample well. The
internal standard can be either the upper marker (260 kD), which is included in the
Pro260 sample buffer, or a user-defined protein (10–<260 kD) added to each sample at
a known concentration.

Absolute quantitation –– Experion software can also create a calibration curve to use
for quantitation. To create the calibration curve, a defined protein calibrant at different
concentrations is separated in different sample wells. The corrected peak areas of the
different concentrations are compared to that of an internal standard (as with relative
quantitation, the upper marker or a user-defined protein can be used as the internal
standard). Experion software plots the resulting ratios as a function of protein 
concentration, and the sample protein concentration is then determined from this 
calibration curve.
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Appendix B — Cleaning the Electrodes

Two types of cleaning procedures ensure the best results from the Experion™ electrophoresis
station: 1) a deep-cleaning procedure, which applies electrode cleaner directly to electrode
pins using swabs, and 2) a routine procedure, which only uses special cleaning chips and is 
performed after every run.

Method 1: Deep Cleaning 
This manual procedure applies Experion electrode cleaner directly to the 16 platinum pins
in the electrode manifold. Perform this procedure:

• Prior to first use of the Experion electrophoresis station

• Between a protein and an RNA analysis

• Any other time when RNase contamination is suspected or any contamination (for
example, salt deposits or other precipitates) is visible on the electrodes 

• Whenever a chip has been left in the instrument for an extended period of time (for
example, overnight)

Perform this procedure with the electrode manifold in place (installed in the electrophoresis
station). It requires the following supplies, all of which are included in the Experion Pro260
starter kit:

• Experion electrode cleaner 

• Experion DEPC-treated water 

• Foam swabs

Warnings: Keep the chip platform completely dry during this procedure. Cover the chip
platform using plastic wrap and a paper towel to protect it from liquid.

1. Ensure that power to the electrophoresis station has been shut off.

2. Add 0.5–1 ml Experion electrode cleaner to a microcentrifuge tube. Insert a swab into
the solution until it is saturated with the electrode cleaner.

3. Use the swab to lightly scrub each electrode pin one at a time, on all four sides. Do not
press too hard on the pins, as they may bend. Finally, clean the tip of each pin. Add
more electrode cleaner to the swab as necessary.

-Or-  

Move the swab up and down, and side to side, 2–3 times along the columns and rows
of pins. Finally, clean the tips of each of the pins. Add more electrode cleaner to the
swab as necessary.

4. Repeat steps 2 and 3 twice, each time with a fresh swab soaked in DEPC-treated
water.

5. Fill a cleaning chip with 800 µl DEPC-treated water, and place the chip in the 
electrophoresis station for 1 min. Then remove the chip.

6. Allow the pins to dry completely by leaving the lid open for at least 10 min.

Note: Refer to the Experion system instruction manual for more details and images.
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Method 2: Routine Cleaning –– Protein Analysis
Use this procedure to clean the electrode manifold in the Experion electrophoresis
station immediately after each run.

Warning: Never store the cleaning chip inside the electrophoresis station. Store the empty
cleaning chip covered to keep the wells clean.

1. Fill a cleaning chip with 800 µl DEPC-treated water10. Gently tap the side of the cleaning
chip to remove any trapped bubbles from the wells.

2. Open the lid of the electrophoresis station and place the cleaning chip on the chip 
platform.

3. Close the lid and leave it closed for 1 min.

4. Open the lid and remove the cleaning chip.

5. Allow the electrodes to dry for 1 min.

6. Close the lid.

7. Replace the water in the cleaning chip after use to avoid contamination. For storage,
remove the water from the cleaning chip and store the chip in a clean location.

10 DEPC-treated water is not required for this cleaning application; however, always use ultrapure (at minimum 0.2 µm-filtered)
water. Do not use autoclaved water.
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Appendix C — First-Time Use of the Experion™

System
The first time that the Experion electrophoresis station is used, do the following:

1. Establish communication between the software and electrophoresis station.

a. Power on the computer.

b. Power on the Experion electrophoresis station by pushing the green button in the
center of the front panel. The steady green LED above the button indicates that
the unit is on.

c. Launch Experion software. Click the Experion software icon on the desktop or
select Start > All Programs > Bio-Rad Laboratories Experion > Experion. If a
prompt appears asking if Windows should block the program, click No.

The following indicate that communication has been established:

• A green dot with the last four digits of the instrument serial number appears in the
lower right corner of the main software screen

• The appearance of an electrophoresis station icon in the upper left corner 

When there is no connection, these indicators are absent and a “disconnected” message
appears next to the Start Run button in the upper left corner of the screen. In 
addition, a grayed-out instrument icon appears in the upper left corner of the software
screen.

2. Confirm that all power saver and/or power options are turned off before starting the
assay (refer to the Experion system instruction manual for more details). Do not let the
computer “sleep” during a run.

3. Clean the electrode manifold using Experion electrode cleaner and the deep cleaning
procedure described in Appendix B.
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Appendix D — Ordering Information
Catalog # Description

700-7000 Experion™ System, 100–120/220–240 V, for protein analysis, includes
electrophoresis station, priming station, software, USB2 cable, instructions
(analysis kits sold separately)

700-7110 Experion Pro260 Starter Kit, includes 3 Experion Pro260 chips, 
1 cleaning chip, Experion reagents, spin filters, IgG protein standard, DTT,
cleaning swabs, electrode cleaner, tips and tubes to run 3 chips, instructions

700-7111 Experion RNA StdSens Starter Kit, includes 3 Experion RNA StdSens
chips, 2 cleaning chips, Experion reagents, spin filters, total RNA standard,
cleaning swabs, electrode cleaner, tips and tubes to run 3 chips, instructions

700-7101 Experion Pro260 Analysis Kit for 10 Chips, includes 10 Pro260 chips, 
3 x 520 µl Pro260 gel, 45 µl Pro260 stain, 60 µl Pro260 ladder (10–260 kD),
400 µl Pro260 sample buffer, 3 spin filters

700-7102 Experion Pro260 Analysis Kit for 25 Chips, includes 25 Pro260 chips, 
5 x 520 µl Pro260 gel, 2 x 45 µl Pro260 stain, 2 x 60 µl Pro260 ladder
(10–260 kD), 2 x 400 µl Pro260 sample buffer, 5 spin filters

700-7151 Experion Pro260 Chips, 10

700-7152 Experion Pro260 Reagents and Supplies, for 10 chips, includes 
3 x 520 µl Pro260 gel, 45 µl Pro260 stain, 60 µl Pro260 ladder (10–260 kD),
400 µl Pro260 sample buffer, 3 spin filters

700-7256 Experion Protein Ladder, 60 µl

700-7251 Experion Cleaning Chips, 10

700-7254 Experion Spin Filters, 10

700-7252 Experion Electrode Cleaner, 250 ml

700-7253 Experion DEPC-Treated Water, 100 ml

163-2091 ReadyPrep™ Proteomics Grade Water, 500 ml

700-7264 Swabs, 25

500-0208 Bovine Gamma Globulin (BGG) Standard Sample, 2.0 mg/ml, 2 ml

VWR87001-688 VWR barrier pipet tips, sterile (narrow-bore, 20 µl universal pipet tips,
RNase-free) (Not available from Bio-Rad. Purchase directly from VWR
Scientific Products)

5395 Experion Training Video: Chip Loading (DVD) (also available at 
discover.bio-rad.com/Experion/)

10000975 Experion Pro260 Analysis Kit Instruction Manual

10001312 Experion System Instruction Manual
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